LAMBDA BIO/XLS PRINT UTILITY

User’s Guide
Release History

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Release</th>
<th>Publication Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>L6050015</td>
<td>A</td>
<td>March 2008</td>
</tr>
</tbody>
</table>

Any comments about the documentation for this product should be addressed to:

User Assistance
PerkinElmer Ltd
Chalfont Road
Seer Green
Beaconsfield
BUCKS
HP9 2FX
United Kingdom

Or emailed to: info@perkinelmer.com

Notices
The information contained in this document is subject to change without notice. **Except as specifically set forth in its terms and conditions of sale, PerkinElmer makes no warranty of any kind with regard to this document, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose.** PerkinElmer shall not be liable for errors contained herein for incidental consequential damages in connection with furnishing, performance or use of this material.

Copyright Information
This document contains proprietary information that is protected by copyright. All rights are reserved. No part of this publication may be reproduced in any form whatsoever or translated into any language without the prior, written permission of PerkinElmer, Inc.

Copyright © 2008 PerkinElmer, Inc.

Trademarks
Registered names, trademarks, etc. used in this document, even when not specifically marked as such, are protected by law.

PerkinElmer is a registered trademark of PerkinElmer, Inc.
Windows and Excel are registered trademarks of Microsoft Corporation.
# Table of Contents

**Introduction** ................................................................................................. 5  
About This Manual ......................................................................................... 6  
Conventions Used in this Manual ................................................................. 7  
Notes .............................................................................................................. 7  

**Installation** ................................................................................................. 9  
Lambda Bio XLS Report Utility Installation .................................................. 10  
   PC requirements ...................................................................................... 10  
   Installing the software ......................................................................... 11  
USB Instrument Connections ...................................................................... 17  
Bluetooth Instrument Connections ............................................................ 18  
   Introduction ......................................................................................... 18  
   Adding a Bluetooth device ................................................................... 19  

**Lambda Bio XLS Report Utility** ......................................................... 25  
Introduction ............................................................................................... 26  
Starting Up the Lambda Bio XLS Report Utility ........................................ 27  
   Main display ....................................................................................... 28  
   Notify icon ......................................................................................... 29  
Setting Up the Printer .................................................................................. 30  
Setting Up Your Instrument Options ....................................................... 31  
   Instrument connection status ............................................................ 32  
   Instrument options ............................................................................. 32  
Checking Your Connections ....................................................................... 35  
   Instrument checks ............................................................................. 35  
   USB connection checks .................................................................... 35  
   Bluetooth connection checks ............................................................ 36  
   Lambda Bio XLS Report Utility checks ................................................ 36  
Synchronizing PC and Instrument Time .................................................... 37  
Receiving Data Reports .............................................................................. 38  
Customizing Report Data .......................................................................... 39  
   Report file names ............................................................................... 39  
   Report timestamps ............................................................................. 39  
   Instrument identification .................................................................... 40  
   User identification ............................................................................. 40  
   Method name .................................................................................... 41  
   Test information ................................................................................ 41  
Exporting .................................................................................................... 42  
   Character sets .................................................................................... 42  
   Exporting to Excel ............................................................................. 42  
Lambda Bio XLS Report Utility Viewer ..................................................... 44  

**Appendices** ................................................................................................. 47  
Appendix 1: Loading the USB Drivers ....................................................... 48  
Appendix 2: Setting up USB serial ports .................................................... 49  
Appendix 3: Com Port Conflicts ................................................................. 55  
Appendix 4: Setting up the COM Port Exclusion List .................................. 57
Introduction
About This Manual

The Lambda Bio/XLS Print Utility User’s Guide provides the information you will need to set up and use your Lambda Bio/Bio+/XLS/XLS+ instrument for saving and printing data using the Lambda Bio XLS Report Utility and Report Viewer applications. For detailed information on your instrument, and using and saving methods, see the Lambda Bio/Bio+ User’s Guide (L6050016) or the Lambda XLS/XLS+ User’s Guide (L6050017), as applicable.

This User’s Guide is divided into the following chapters:

Introduction

This chapter contains a brief introduction to the conventions and warnings used in the manual.

Installation

This chapter has information on installing the Lambda Bio XLS Report Utility and the Lambda Bio XLS Report Viewer software applications and installing the various COM ports for connecting your instrument to the PC via USB or Bluetooth.

Lambda Bio XLS Report Utility

The chapter describes the main features of the Lambda Bio XLS Report Utility and how to use the software with your instrument. It also describes the use of the Lambda Bio XLS Report Utility Viewer to display your reports.

Appendices

This chapter contains additional reference information about setting up COM ports.
**Conventions Used in this Manual**

Normal text is used to provide information and instructions.

**Bold** text refers to text that is displayed on the screen.

UPPERCASE text, for example ENTER or ALT, refers to keys on the PC keyboard. “+” is used to show that you have to press two keys at the same time, for example, ALT+F.

All eight digit numbers are PerkinElmer part numbers unless stated otherwise.

**Notes**

Three terms, in the following standard formats, are also used to highlight special circumstances and warnings.

| NOTE: | A note indicates additional, significant information that is provided with some procedures. |
Installation
Lambda Bio XLS Report Utility Installation

**NOTE:** Do not connect an instrument to the PC until the Lambda Bio XLS Report Utility software is installed.

**PC requirements**

Before starting the installation process ensure the following requirements are met:

- Windows XP Service Pack 2 operating system must be installed on the PC.

- To install Lambda Bio XLS Report Utility software you must be logged into Windows with full administration rights. If not, then installation may fail. If in doubt, consult your PC Administrator.

  To see if you have administration rights, select **Control Panel** from the Start menu and then select **User Accounts**.

- To connect to instruments via USB, USB to serial port drivers must be loaded into the Windows system directory.

- If the instrument will be connected by USB 2.0, then the PC must be fitted with a Universal Serial Bus controller and USB connectors.

- If the instrument will be connected by Bluetooth, then the instrument must be fitted with a Bluetooth module and the PC must support Bluetooth (either on-board or via a USB Bluetooth adaptor).

- If you intend to export directly to Microsoft Excel, then the PC must have Excel 97 or a later version installed.
Installing the software

NOTE: Do not connect the instrument to the PC until the software is installed.

The Lambda Bio XLS Report Utility should be installed onto the PC to which you intend to connect instruments and run the software. The installation process carries out the following:

- Installs the Microsoft .NET Framework and Windows Installer (unless already installed on the PC);
- Installs the Lambda Bio XLS Report Utility Software;
- Installs USB Drivers for the instrument.

The procedure is as follows:

1. Insert the CD-ROM (L7110223) into your PC’s CD-ROM drive.
   The CD should Auto play, starting the installation process automatically. If it does not, navigate to the CD-ROM in Windows Explorer and then double-click the setup.exe file.
   Initial checks determine whether the Microsoft .NET framework and Microsoft installer software is already installed on your PC. If not, a copy of this software will be installed from the installation disk. If this occurs, then you must accept the License Agreement to continue. You may then need to re-start the computer. Please be patient – the process could take some time. The installation will continue when the PC has re-started.

   When satisfied that all pre-checks have passed, the Welcome to the Lambda Bio XLS Report Utility Setup Wizard page is displayed.
2. Click **Next** to continue.  
The License Agreement page is displayed.

3. Please read and accept by selecting **I Agree** and then click **Next** to continue.  
The Select Installation Folder page is displayed.

4. Enter the location you wish the software to be installed to.

5. Select whether to install the software for **Everyone** or for **Just me** using the PC.  
   We recommend that you install the software for **Everyone** so that the desktop icons and Start menu items are visible to all users.
6. Click **Next** to continue. The Confirm Installation page is displayed.

![Confirm Installation](image1)

7. Click **Next** to start the installation. The Installing Lambda Bio XLS Report Utility page is displayed. A progress bar is shown during the installation.

![Installing Lambda Bio XLS Report Utility](image2)
The USB to Serial port driver installation page is displayed.

**NOTE:** If the instrument will be connected using a USB cable, then the USB drivers need to be installed.

8. To initiate the installation of the FTDI USB drivers, click **Install USB drivers**. A command box is displayed.
9. When the drivers installation is complete, clear the USB driver installed confirmation screen by using the ENTER key.
   The USB to Serial port driver installation page is redisplayed.

10. Click **Next** to continue.
    The installation will continue. The Lambda Bio XLS Report Utility Read me notes are then displayed. This text file contains summary information on how to install and connect instruments to the software. It also provides answers to frequently asked questions.
11. Click **Next** to continue.
   Installation Complete page is displayed.

   ![Installation Complete](image)

   Lambda Bio/XLS Report Utility has been successfully installed.
   Click “Close” to exit.

   Please use Windows Update to check for any critical updates to the .NET Framework.

12. Click **Close**.
USB Instrument Connections

- Before connecting to an instrument the USB drivers must be installed. If you did not set up the drivers as part of the software installation, see Appendix 1: Loading the USB Drivers on page 48.

- If connecting the instrument for the first time to the PC via USB, the COM port that the instrument will use when connected to the PC needs to be set up. On some systems this USB installation process will happen automatically when an instrument is connected to a USB port. If this does not occur, see Appendix 2: Setting up USB serial ports on page 49 for more information.

- Next time the instrument is connected using the USB cable a notification bubble may appear, but you should not need to re-install the USB drivers.

- When additional instruments are connected to the PC using USB connections, you should not need to go through the installation process again, but notification bubbles and audible notifications may appear to indicate that the connection has been detected.

- You can remove the USB cable from either the instrument or the PC when it is switched on without damaging the hardware, but we recommend that any software using the link is deactivated or shut-down first. Failure to properly close down a COM port can sometimes lead to it being locked out from another application. You can use the Lambda Bio XLS Report Utility STOP command for this purpose.

- If the PC has a speaker, then an audible notification may be heard when the USB cable is inserted or removed from the PC.

- The COM port used by an instrument will change if the USB cable is inserted in a different USB socket. If required, use the Windows Device Manager to determine which COM port is used when the USB cable is inserted; see Serial Port Allocation on page 53.
Bluetooth Instrument Connections

Introduction

• The Bluetooth module is an optional accessory for the instrument. Please refer to the Accessory installation instructions in the Lambda Bio/Bio+ User’s Guide (L6050016) or the Lambda XLS/XLS+ User’s Guide (L6050017) on the Lambda Bio/XLS User Manuals CD (L6050018).

• The Bluetooth Module cannot be installed simultaneously with the built-in printer option.

• When installed, data can be sent to a PC either by Bluetooth or USB, but these options cannot be used simultaneously.

• The host PC will also need a Bluetooth ‘radio’ device. A USB to Bluetooth adapter is available separately. Make sure the Bluetooth Hardware has been installed on the PC in accordance with the manufacturer’s instructions.

You need to add each instrument that is to be connected using Bluetooth to the list of known Bluetooth devices. For security reasons, Bluetooth devices use a pass key pairing system when establishing a connection. The connection process can be simplified by setting up the pairing information on the PC as part of the device information and arranging for devices to automatically pair and connect when discovered. The instrument serial number is used as the pass key or PIN. You will need to provide this information during the configuration of the Bluetooth device. Do not be tempted to bypass the pairing definition, as this only complicates the process of opening a port associated with an instrument.

When an instrument is successfully installed as a Bluetooth device it will be associated with a serial port that will be visible in the Windows Device Manager.

![Figure 1 Windows Device Manager, showing Bluetooth ports](image)
The Bluetooth hardware fitted to your PC may have come with its own software interface for creating Bluetooth device serial service connections. The following example is typical of a Bluetooth device set up, but the exact format of the setup Wizard or access to it may be different on your computer.

Various Bluetooth adaptors will provide associated software, often specific to that vendor. It has been our experience that not all of these work successfully with all Bluetooth devices providing serial port services such as the spectrophotometer Bluetooth accessory we provide. The best results have been obtained by using the generic Microsoft drivers, which are included in Windows. If the device is not compatible with these drivers it may not work well with this accessory. Please note that we cannot support third-party software.

**Adding a Bluetooth device**

1. From the Windows control panel double-click **Bluetooth Devices**.

   ![Bluetooth Devices dialog](image)

   The Bluetooth Devices dialog is displayed.
This shows the currently defined and allowed list of Bluetooth devices known to the PC.

2. To add a new Bluetooth connection to an instrument, start the wizard by clicking on **Add**.

The Welcome to the Add Bluetooth Device Wizard page is displayed.

3. Ensure that the instrument is fitted with the Bluetooth module and that the instrument is powered and switched on.

**NOTE:** The instrument Bluetooth module needs to be configured after installation. This configuration is automatic, but requires that the instrument is switched off and on again after installation.
4. Select the check box and then click **Next**.

The wizard searches for all discoverable devices.

When the search has completed, all discovered devices are shown in a list. New devices are identified as such. Lambda Bio/XLS instruments are identified as **Spectro**, followed by the last 6 characters of the Bluetooth module number.
5. If the instrument was not found, check the module fit and retry by clicking on **Search Again**. When the instrument has been found, select the new device and then click **Next**.

The Do you need a passkey to add your device page? is displayed.

6. Select **Use the passkey found in the documentation** and type in the instrument serial number.

You can view this on the instrument **Utilities About** dialog. Alternatively, it should be on a label attached to the instrument.

The wizard will then attempt to connect and discover the services provided by the Bluetooth device. The instrument provides a serial port **Spectro** service and the wizard will automatically allocate a pair of COM ports to this device.

The Completing the Add Bluetooth Device Wizard page is displayed. The serial ports allocated for the Bluetooth connection are shown.
7. Click **Finish** to return to the Bluetooth devices dialog. The list of known devices now includes the new instrument.

![Bluetooth Devices dialog](image)

8. Add further instruments to the list of Bluetooth devices in the same way.

- To view the serial port associated with the instrument select the COM Ports tab. The ports used by Lambda Bio XLS Report Utility for communication with the instrument will be marked with **Spectro**.

![COM Ports tab](image)

You can also use the Windows Control Panel, Device Manager, **Ports** list, to determine port usage. (Note that the other port allocated to this service is not actually used in this scenario.)
Lambda Bio XLS
Report Utility
Introduction

Lambda Bio XLS Report Utility enables one or more Lambda Bio/XLS spectrometers to transfer data to a PC. From there the data can be both printed and saved (in a variety of formats).

The Lambda Bio XLS Report Utility:

- Can connect to several instruments simultaneously, limited only by hardware and the speed of the host system;
- Can operate via USB, Bluetooth or USB/Bluetooth simultaneously;
- Can store data either to a common directory or be configured to save to independent directories according to file format and/or instrument;
- Can save data in graphics format, text format or as an Excel format file (Excel must be installed on the PC to allow this format);
- Can print to any printer connected to the PC, including Network printers;
- Can be configured to automatically save and print data.

See the installation instructions for the Lambda Bio/XLS Print Utility in Installation on page 9. This chapter assumes both USB and Bluetooth COM ports have been already set up and the instruments connected via either method.
Starting Up the Lambda Bio XLS Report Utility

To start Lambda Bio XLS Report Utility:

- Double-click the Lambda Bio XLS Report Utility desktop icon.

OR

Select the Lambda Bio XLS menu from the Start menu, and then select Lambda Bio XLS Report Utility.

The notify icon will appear in the Tray area of the Windows tool bar:

Various notification bubbles will indicate the progression of the start-up process:

The start-up process recovers application settings and searches for attached instruments on Bluetooth and USB serial ports. When start up is complete the main display will be shown.

**NOTE:** The operator must have privileges to read and modify the Lambda Bio XLS Report Utility key and its subkeys stored within the HKEY_LOCAL_MACHINE SOFTWARE PC registry. An Administrator or standard User should have these privileges by default, but a restricted user probably will not. This key holds application settings and instrument information. The key and subkeys are created for the first time when the software is run. A new subkey is created for each new instrument found attached. When options for an existing instrument are changed, subkeys associated with the instrument key are modified to reflect the changes. Without modify rights it is likely that you will encounter registry access denied errors.

**NOTE:** Lambda Bio XLS Report Utility was not designed to be run remotely from a networked computer. This would require the operator to read and modify registry values on the remote computer where the software was installed. It is unlikely that anyone other than an Administrator with full registry modification rights in the local domain would be able to read, let alone modify, the registry settings. Please ensure that Lambda Bio XLS Report Utility is installed on the computer on which the operator will work.
Main display

The main display lists all the instruments known to the application, irrespective of whether a connection is currently active. As new instruments are attached they are added to the list of known instruments. Instruments are identified by product name and serial number.

The traffic indicator, Activity text and font color are used to describe instrument status and indicate the current activity:

- Red is not connected;
- Yellow is connected but waiting for data;
- Green is used when data is being received, printed, saved or exported.

From the main display you can:

- See the Activity status of connected instruments.
- Start a new search for connected instruments by clicking Find.
- STOP the Lambda Bio XLS Report Utility running and disconnect from all instruments, by clicking STOP. Windows does not always handle the disconnection of USB serial ports well, so if a unit is disconnected and then re-connected the data link can be lost without Lambda Bio XLS Report Utility being aware of the problem. This could lead to loss of data, so it is recommended that you use STOP before attempting disconnecting and reconnecting the USB leads.
- Use the Options icon to set up display, save, print and export options for an instrument in the list.
- Remove an instrument from the list that is no longer used on that PC. Select the instrument and use the DELETE key. You can not remove an instrument that is currently connected.
- Set up the default printer for the application (accessible from the File menu).
- Hide the main display (accessible from the File menu). Alternatively, click in the caption bar.
- Exit the application (accessible from the File menu).
- Synchronize instrument date and time to the PC date and time (accessible from the Tools menu).

- Define a port exclusion list to speed up the instrument search (accessible from the Tools menu; see Appendix 4: Setting up the COM Port Exclusion List on page 57 for more information).

- Display version information (by clicking 📁).

**Notify icon**

If the main display has been closed, then clicking on the notify icon 📱 will re-display the main window.

Right-clicking on the notify icon produces a menu that allows you to access the options Display, Setup Printer and About Lambda Bio XLS Report Utility. The Exit command closes the application.
Setting Up the Printer

The Lambda Bio XLS Report Utility software facilitates the printing of report data received from an attached instrument on any printer accessible from the PC. To print report data automatically a default printer must be set up.

NOTE: You will be asked to enter this information when starting up the Lambda Bio XLS Report Utility software for the first time.

To change or view the current setting:

1. Select Printer from the Setup submenu of the File menu.

   ![Printer Selected dialog](image)

   The Printer Selected dialog is displayed.

   ![Printer Selected dialog](image)

   2. Select the printer Name from the drop-down list.

      The Current printer is that presently being used by the Lambda Bio XLS Report Utility.

      The Default is the printer set up as the Windows default printer.

   3. Click OK to save the selection.
Setting Up Your Instrument Options

When the Lambda Bio XLS Report Utility has connected to an instrument, identification and options for the instrument are stored in the Lambda Bio XLS Report Utility application settings.

To view current settings for an instrument, select the instrument in the list and then click the Options icon. The Instrument report configuration dialog is displayed.

The Instrument report configuration for an instrument has two main parts. The top panel shows the connection status information; underneath the option properties are displayed. These are discussed in more detail in the following sections.


**Instrument connection status**

This status panel repeats the instrument product model name and serial number. It also displays whether connection has been made to the instrument and which COM port is being used to make the connection.

The connection diagnostic information includes:

- The method used for connection: either 📲 for USB or 📱 for Bluetooth.
- Whether this port has been set up as the printer port on the instrument (Configured). Connection can be made to an instrument using a USB cable, but the instrument could be set to use an internal printer. Alternatively, a Bluetooth connection could be assumed but the instrument set to use USB.
- Whether the instrument was set to Auto print when connection was established. An instrument not set to Auto print will only produce print report data when the instrument Print key is pressed.

➢ To remove an instrument from the list of known instruments, click Remove. This will remove all knowledge of the instrument from Lambda Bio XLS Report Utility and return you to the main display.

**Instrument options**

There are four property sections:

- **Data directories** defines the folders where different types of data will be stored;
- **Excel export templates** is used in conjunction with Excel export and allows you to select a work book template to use;
- **Report related properties** allows additional information to be added to each report received;
- **When report received** selects what action to take when a report is received.

**NOTE:** The settings for one instrument are independent to any other instrument settings, and so it is possible for a user to maintain division between data from different instruments and to customize reports for a particular session.

**Data Directories**

The data directories default to a data folder, located below the Lambda Bio XLS Report Utility installation location, but each can be set to any folder accessible by the computer. The path can be entered manually in the right-hand column, or the browse button at the end of the field can be used to navigate to or create a new data folder. The field is shown blank and cannot be changed, if the option to save the data is disabled in the When report received section.
**Excel export templates**

The Excel export process normally creates Excel data files using the default Excel workbook template. The Use Template option allows the selection of a user-customized template. The selected template field is blank and cannot be changed unless the use field is enabled.

**Report related properties**

These fields can be edited directly by typing in the property value area.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Description</td>
<td>This allows a header box containing up to 255 characters to be added to the top of each received data set.</td>
</tr>
<tr>
<td>Report Title</td>
<td>This adds a standard title bar to the top of each received data set.</td>
</tr>
<tr>
<td>Root file name</td>
<td>This adds a user-defined prefix to the stored file name. File names are constructed as follows: &lt;Root Prefix&gt; &lt;Method name&gt; &lt;PC date&gt; &lt;PC time&gt;.&lt;File type&gt;</td>
</tr>
</tbody>
</table>

**When report received**

This section defines the actions taken when a complete data report is received from the instrument. To change the setting, click on the item and use the drop down list or double-click the item to go through the options.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Report</td>
<td>This selects whether the report is displayed when it is received from the instrument. Two display options are available, either Complete or Graph only. The report can be printed, exported or saved from the displayed view.</td>
</tr>
<tr>
<td>Print report</td>
<td>Sends the report to the default printer defined in the Lambda Bio XLS Report Utility.</td>
</tr>
<tr>
<td>Save Report</td>
<td>Saves the file in the native Lambda Bio XLS Report Utility format (.PVC). This can be viewed later using the Lambda Bio XLS Report Utility Viewer, and then printed or saved from there in a variety of formats.</td>
</tr>
<tr>
<td>Save Report Graph to EMF Format</td>
<td>This saves the graph output as an EMF (Extended metafile) File, an editable graphics format.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Save Report to XXX format</td>
<td>This saves the report in a variety of formats for future use. These are defined as follows.</td>
</tr>
<tr>
<td></td>
<td>CSV (Comma separated variables): This is a data format suitable for transfer to a variety of data handling systems.</td>
</tr>
<tr>
<td></td>
<td>EMF (Extended metafile): This is an editable graphics format.</td>
</tr>
<tr>
<td></td>
<td>XLS (Excel spreadsheet format): Data is created in a number of sheets depending on the report data being exported. Each page of report information will use separate worksheet and each graph will generate a chart data worksheet and accompanying chart sheet. The work book template used to create the file can be changed from the default to one you select.</td>
</tr>
</tbody>
</table>

**NOTE:** To use this facility, Excel must be installed on the PC.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RTF (Rich text format): An editable text format for use in Word™ and other word processor software packages</td>
</tr>
<tr>
<td></td>
<td>TSV (Tab separated variables): A data format suitable for transfer to a variety of data-handling systems</td>
</tr>
</tbody>
</table>
Checking Your Connections

To prevent loss of data it is important to ensure that instrument settings are correct and that instrument connection has been established before any measurements are made.

Instrument checks

To ensure the instrument you are using is set up for use with Lambda Bio XLS Report Utility:

- Power up the instrument before the Lambda Bio XLS Report Utility searches for instruments.

**NOTE:** An instrument connected to a power supply will be able to establish a USB or Bluetooth connection on the PC, but without starting up the instrument, Lambda Bio XLS Report Utility will find the port unresponsive.

- Check that the instrument is configured to print to the Lambda Bio XLS Report Utility.
  On the instrument go to the Printer section on the Utilities screen and then select the appropriate connection method, Computer (Bluetooth) or Computer (USB), using the left and right arrow keys.

- Ensure that the Auto print setting is appropriate for your working practice.
  With Auto print ON a report will be generated automatically by the method running.
  With Auto print OFF the operator must invoke data printing by clicking on the appropriate option key. Auto print can be switched ON or OFF as a default system setting within the Printer screen in the Utilities section of the instrument software, but the Auto print setting can be overridden in individual methods.

USB connection checks

To use USB connections check the following:

- The USB cable is plugged in at both ends.
  The serial port associated with the USB connection will not be apparent to Lambda Bio XLS Report Utility until you have plugged in the cable. If you unplug the cable the associated serial port will disappear from the port list.

**NOTE:** Connection to the instrument does not guarantee that printer data will be output.

- You have installed the FTDI USB to serial port drivers on the PC.

- Changing USB ports will change the associated serial port used by the connection.
  Ensure that this port has not been excluded from the instrument search (see Appendix 4: Setting up the COM Port Exclusion List on page 57).
**Bluetooth connection checks**

To use Bluetooth connections check the following:

- Ensure that instruments that you intend to connect using this method are fitted with a Bluetooth module.

- You have installed a Bluetooth radio device on your PC.

- If the Bluetooth connection is achieved using a USB dongle, it must be fitted and enabled.

**NOTE:** The port associated with a Bluetooth connection will be visible to Lambda Bio XLS Report Utility as soon as the dongle is inserted and enabled. This does not necessarily mean that an instrument exists on the end of the connection.

- Ensure that the instrument is in range of the PC Bluetooth radio. The range is usually 10 m or 100 m but can be influenced by physical structures.

- A dropped Bluetooth connection may not re-establish itself automatically. If you suspect that a connection has been interrupted it would be prudent to get the Lambda Bio XLS Report Utility to conduct a new instrument search.

**Lambda Bio XLS Report Utility checks**

Use these checks to ensure the instrument has connected and is configured.

- Check that the instrument you wish to work with is in the list of known instruments. If it is not shown, perform the USB or Bluetooth connection checks as appropriate and then click **Find** to search again.

- Check the instrument is shown as **Connected**. If not, perform the USB or Bluetooth connection checks as appropriate and then click **Find** to search again.

- Check that the port used for connection is not in the port exclusion list (see *Appendix 4: Setting up the COM Port Exclusion List* on page 57).

- Check the options for the connected instrument are set up appropriately for your working practice. The report will only be displayed if enabled to do so; saving in Lambda Bio XLS Report Utility format will only occur if the save action is enabled; printing will only occur if the action to print is enabled and a default printer has been set up; export in a particular format will only occur if the appropriate setting has been enabled; and Excel export will only happen if Excel is installed on the PC and the action has been enabled.

- In the options dialog, check the connection status panel for diagnostic information (if available). This can help to diagnose why data is not being received if, for example, there are inappropriate instrument settings.
**Synchronizing PC and Instrument Time**

If the instrument date and time and PC Date and time are different then confusion can arise because the internal report date and time could be markedly different to the file name timestamp. For this reason it is often convenient to synchronize the instrument date and time with the PC setting.

- To synchronize the data and time with the PC data and time, select **Synchronise time** from the **Tools** menu.

This will temporarily stop the collation of report data (and so is best done before starting a Lambda Bio XLS Report Utility session) and updates all connected instruments with the PC Date and Time. It will then automatically conduct a new search for instruments and restart the report data collection mode.
## Receiving Data Reports

Instrument print data is only sent to Lambda Bio XLS Report Utility when:

- Auto print has been enabled on the instrument and a test has been performed;

- A test has been performed and the instrument Print option (accessed from the Options key) is invoked. (If Auto print is disabled and the Print option key is used, then only the last test performed will be added to the print report.)

A method that creates many result values during a single run or involves a complex multistage procedure will probably produce a complete report per run of the method. By contrast, a method that provides a simple test result per run will usually add each run result to a single method report result table.

For example, in the Spectrum method, a new print report is generated with each run. However, in the Single Wavelength method the settings information forms the first part of the report followed by a result table. Each run produces one new result that is appended to this table, but the report is not deemed complete until all test results have been taken – this is implied by you leaving the method. Therefore, only when you exit the method is the printed report completed. This approach makes subsequent data manipulation easier for you, as all the results are in a single table. It also uses less paper.

If the instrument has been correctly set up to print, and all connection and Lambda Bio XLS Report Utility checks have been performed, and a report still has not been displayed, printed or exported, then it may simply be that you need to exit the method first (on the instrument, use the Cancel, Escape or Back key). However, it is possible that if the connection to the PC was not correctly made or the instrument set up was not done correctly, this may not be discovered until after the measurements have been taken. For this reason it is recommended that the connection to Lambda Bio XLS Report Utility is proven before starting a measurement session. (This can be done using a method such as Spectrum to verify that connections and option settings are correctly set up.)
Customizing Report Data


This means you can customize file names, data locations and add information to reports on an individual basis. Stored report data is also associated with a date and time associated with the report generation timestamps.

Report file names

The file names used for storage and export of report data are composed of the following:

\(<\text{Root Prefix}> \ <\text{Method name}> \ <\text{PC date}> \ <\text{PC time}>.\text{File extension}\)

where

- \(<\text{Root Prefix}>\) is defined on the options page for the instrument (see Instrument options on page 32);
- \(<\text{Method name}>\) is the method name supplied by the instrument, for example, Single Wavelength;
- \(<\text{Date}>\) is the PC date when the report was completed, in the order YEAR-MONTH-DAY, allowing Windows Explorer to sort in ascending or descending date order;
- \(<\text{Time}>\) is the PC time when the report was completed, in the order HOUR-MINUTE-SECOND, allowing Windows Explorer to sort files in ascending or descending time order;
- \(<\text{File extension}>\) reflects the format of the data stored.

For example:

LambdaReport SINGLEWAVE 2007-06-01 11-20-10.PVC

Report timestamps

All reports have timestamps associated with them. Timestamps enable the tie-up of reports with particular method sessions.

File name date and time

The PC date and time is used as a timestamp element in the formation of all file names used to save report data. The timestamp is when the report was completed.
Report data timestamp

When the start of the report is received by Lambda Bio XLS Report Utility, the PC date and time is used to fill in a report started timestamp. (This is distinct from the completion timestamp used in file names.)

**NOTE:** By default the report data timestamp is shown in the right header position, but can be overridden by report header settings defined by the method.

The instrument method normally provides its own report start timestamp, and where this information is received it is used to override the setting created by Lambda Bio XLS Report Utility. A timestamp derived from the instrument will reflect the instrument date and time setting.

**NOTE:** If the instrument date and time and PC Date and time are different it can cause confusion when comparing timestamps, so it can be useful to synchronize the instrument date and time with the PC. See Synchronizing PC and Instrument Time on page 37.

Each instrument method has its own report layout, but will normally include the report time stamp within the method report summary details preceding the result tables.

Test result timestamp

For methods in which each run generates a new test result that is stored in the same report, then each test result is time stamped. The format of this timestamp depends on the instrument method, but will reflect the date and time on the instrument.

**NOTE:** See Receiving Data Reports on page 38 for more information on when test data is sent to the software from the instrument.

Instrument identification

The report data always contains instrument identification, including product name and product serial number, but to access this information you need to view the data report.

To help you to easily identify data files associated with a particular instrument, on the options page for the instrument:

- All the data directories can be set to have a common directory root that identifies the instrument;
- The file name prefix can be changed to identify a particular instrument.

User identification

If you need to identify the person using an instrument or carrying out a method, then this can be done within the report or the identification can form a part of the file name or location.

To associate a data file with a person, for this session, on the options page:

- The data directory root can be changed to identify a person;
- The file name prefix can be changed to be the person’s name.
To add user identification into the report itself, on the options page for the instrument add one or more of the following:

- Report title;
- Report description.

**Method name**

The report data always identifies the source method. The method name is normally included in any report file name created; see *Report file names* on page 39.

If required, this information can be augmented by:

- Changing the file name prefix;
- Adding a Report Title for the session;
- Adding a Report Description for the session.

**Test information**

It is sometimes useful to add test information to a report that helps describe the purpose of the test or a description of the test conditions. This can be done directly to the report by:

- Adding a Report Title for the session;
- Adding a Report Description for the session.

Alternatively, the report can be exported and the information added in your own report generator.
Exporting

Lambda Bio XLS Report Utility can export the report data in a variety of different file formats. The generated report usually consists of a single results page containing a header, all the report information and a footer, but some instrument methods might specify more than one result page. Then each page would have its own header and footer.

**NOTE:** Some report export formats may be inappropriate. For example, an EMF graph only format would not be very useful where the application report did not generate a graph. In such cases a message will indicate that there is no data to show.

Character sets

Lambda Bio XLS Report Utility uses UNICODE characters, allowing it to generate report data using a mixture of Western European characters and other characters. This is necessary because, for example, by setting the language on an instrument to Japanese, method reports may be created that contain a mixture of Western and other characters.

**NOTE:** Some old applications (or old versions of applications) may not be Unicode aware and might attempt to map the Unicode characters to ANSI when loading a file. This can lead to incorrect mapping of characters or the insertion of extra characters. PerkinElmer does not support third-party software.

When Windows is installed on a PC the fonts installed by default are chosen based on the international Locale specified. A PC set up to use the Western European character set by default is unlikely to have Japanese character sets loaded. In that case, applications may not be able to map certain Unicode character values to character representations (and question marks may be shown). If you need to work with a language such as the simplified Japanese supported by the Lambda Bio/XLS instruments, then you will need to have the appropriate fonts installed on your PC.

Exporting to Excel

Excel can be configured to auto format some fields in accordance with local conditions. This can lead to issues when dates and times and numbers that do not apparently conform are imported into cells. The information supplied by an instrument as part of the report data can contain such information and the format of such text embedded in a report depends upon the instrument programming and instrument user settings. For this reason it is sometimes necessary to import into cells using a text format rather than a date or numeric format.
**Excel direct export**

Lambda Bio XLS Report Utility uses the Microsoft Office Interoperability interface to transfer print data into Excel file format. The interface supplied is compatible with Excel version 97 or later versions. This overcomes many of the problems experienced in trying to import file data into Excel that can result when the data contains different numeric decimal point representation or use of special characters. To use this facility requires that the Excel application be accessible from the Lambda Bio XLS Report Utility application. Direct Excel export is not possible unless Excel is found. The direct export allows Lambda Bio XLS Report Utility to create result worksheets that maintain the majority of the original report color and font attributes. It also creates separate result sheets and chart sheets that plot the result data automatically. Normally Excel export is done using the default Excel work book template but it is possible to use a previously defined custom template. This does not affect the storage or generation of work sheets but allows the file created to contain additional sheets and macros that might be useful to manipulate the exported data.

**Excel export using CSV file**

Lambda Bio XLS Report Utility CSV export does not require Excel to be present on the PC. The fields are separated using the character defined as a list separator in the PC Windows Control Panel Regional Settings (normally a comma but semi colon is used in some European countries). These files are text only, but they do contain the tabulated graph data. Excel is able to recognize .CSV files and can load these files automatically. The customer can select the graph data and then create their own charts.

**NOTE:** The automatic Excel import may assume the use of ANSI characters and confuse some characters during loading. It may also attempt to split up numbers where instrument settings use comma instead of point for the decimal point representation and this disagrees with the PC settings.

**Excel export using TSV file**

This is a similar approach to the CSV file format but using tab as a separator. Here you can use the Excel import wizard and have greater control of the import process. This approach overcomes the problems associated with the use of comma for the decimal separator.
**Lambda Bio XLS Report Utility Viewer**

This is a separate application that allows you to display Lambda Bio XLS Report Utility format files. The report data can then be printed, saved or exported.

![Lambda Bio XLS Report Viewer](image)

**Figure 2 Lambda Bio XLS Report Viewer**

To start up the Lambda Bio XLS Report Utility Viewer application:

- Double-click the Lambda Bio XLS Report Utility Viewer desktop icon.

  OR

  Select the Lambda Bio XLS Report Utility Viewer item in the Start, All Programs, Lambda Bio XLS menu.

**NOTE:** To enable the viewing of incoming reports from an instrument, set the instrument option **Display report** to **Complete** or **Graph only**. This will open the Report Viewer with the report displayed when the report is received from the instrument.

To view an existing report data file:

1. Click **Load file**.

   The Open dialog is displayed, which allows you to select files with the Report Utility format data file (.PVC). The dialog opens at the default location for the data directory.
2. Select the required file and then click **Open**.

The report displayed; for example:

![Example of Report Display](image)

**Figure 3 Example of Report Display**

**NOTE:** You can view an existing Lambda Bio XLS Report Utility data file (.PVC) directly by double-clicking on it. This starts the application with the report displayed.

**NOTE:** You can also open report files that were saved onto an SD Memory Card if installed in your instrument. Plug the SD Memory Card into the card reader on your PC and navigate to the print utility folder on the SD Memory Card.

The toolbar icons **First page**, **Previous page** and **Next page** allow you to browse through the displayed pages of received data. Alternatively, you can use the keyboard PAGE UP and PAGE DOWN keys.

**NOTE:** The term “page” here refers to displayed pages not printed pages. Changing the size of the displayed window may change the number of displayed pages.

The **Complete/Graph only** selection determines whether the full report or just the graphs are shown.

The **Save As** icon allows you to save the file as a native Lambda Bio XLS Report Utility file with a user defined name into a chosen location.

**NOTE:** You can choose any file name, but the file extension is fixed (PVC).

The **Export** icon allows you to save the report in any of the formats described in **Instrument options** on page 32.
**NOTE:** You can choose any file name. Excel export is only possible on a PC on which Excel has been installed; after defining the file name, you are requested to select a work book template. Select your own template or click **Cancel** to use the Excel default template.

The 🖨️ **Print** icon prints the report to a printer you can select from a drop-down list of printers known to the PC.
Appendices
Appendix 1: Loading the USB Drivers

If you had problems installing the FTDI drivers or chose not to install the drivers when you installed the Lambda Bio XLS Report Utility, then you will need to refer to the instructions below before connecting an instrument via a USB connection to the Lambda Bio XLS Report Utility.

**NOTE:** To install the drivers on your PC you will need to be logged on as an Administrator.

1. Disconnect all instruments from the computer USB ports.
2. Using Windows Explorer, navigate to the installation directory for Lambda Bio XLS Report Utility, and then open the USB drivers folder.

3. Locate the FTDI driver installation application and then run by double-clicking CDM 2.02.04.exe.
   
   When the installation is complete the Windows command box is displayed.

4. Press ENTER to close the command box.
   
   The drivers have now been installed.
Appendices . 49

Appendix 2: Setting up USB serial ports

After installing the drivers on your PC as part of the software installation, the next step in the USB connection installation process is to create the port to be used by the instrument when it is plugged into the PC.

NOTE: If you did not install the drivers when you installed the Lambda Bio XLS Report Utility, then you will need to refer Appendix 1: Loading the USB Drivers on page 48 before connecting an instrument via a USB connection.

The virtual communications port consists of two components:

- USB to Serial Converter;
- USB Serial Port enumeration.

On some systems this part of the USB installation process will happen automatically when an instrument is connected to a USB port. If this does not occur, then the installation will proceed using the operating systems Found New Hardware Wizard, as described below.

**USB to Serial Converter**

1. Connect the instrument to the USB port of the computer and then switch on the instrument.
   The computer will detect that new hardware has been found.

   ![Found New Hardware Wizard](image)

   Depending on your security level settings, the Found New Hardware Wizard may first display a page asking whether it can search for the additional driver software.

   ![Found New Hardware Wizard Interface](image)
2. Click **Yes, now and every time I connect a device** and then click **Next**. Alternatively, click **Yes this time only**, but this means you will be presented with the screen every time the Found New Hardware Wizard is initiated. The Welcome to the Found New Hardware Wizard page is displayed.

The wizard will help you to install software for **USB <-> Serial**.

3. Select **Install the software automatically (Recommended)** and then click **Next**. It can take a few minutes while the wizard searches for the software.

When the wizard has completed, the Completing the Found New Hardware Wizard page is displayed.
4. Click Finish.
   The Found New Hardware Wizard will then re-start to install software for USB Serial Port (see USB Serial Port Enumeration, below).

**USB Serial Port Enumeration**

1. If a security screen requesting permission to search for the software is displayed, click Yes, now and every time I connect a device and then click Next.
   The Welcome to the Found New Hardware Wizard page is displayed.
2. Select **Install the software automatically (Recommended)** and then click **Next**.
   The wizard will search for the software and then install it. This could take a few minutes. When the wizard has completed, the Completing the Found New Hardware Wizard page is displayed.

3. Click **Finish**.
   The USB Serial Port should now appear under Ports in the Windows Device Manager.

Further instruments may now be connected. This will probably cause a notification bubble to appear indicating that the connection has been detected but should not invoke any installation process. The port list should refresh after a short period to show the new ports added.
**Serial Port Allocation**

The USB driver serial port enumerator will allocate the next free COM port to the USB connection used. Once allocated, this USB connection will always be associated with the same serial port. If you use a different USB connection this will be associated with a different serial port. The installation of a USB hub would normally reserve a range of COM ports, but inserting the hub into another USB connection can cause a new range of COM ports to be reserved. This can lead to unexpected allocation of serial ports.

To view allocated serial ports, access the Windows Device Manager as follows:

1. Select the Windows Control Panel and double-click the **System** item. The System Properties dialog is displayed.

![System Properties](image)

2. Go to the Hardware Tab and then click **Device Manager**.

![Device Manager](image)

**NOTE:** Some allocated COM ports may not appear in this list but may be used by other devices such as modems. When a new device is connected it is usually assigned the lowest free COM port.
To determine which COM port each instrument is assigned to, watch the Device Manager update as you insert each USB cable.

The USB port of an instrument will be active if the power is connected, even if the instrument is turned off.

**NOTE:** Normally a driver will allocate the next available and unused port, but occasionally port allocation conflict can occur. This would normally happen only if you have mistakenly allocated a connection to a port already in use. If this problem occurs, then you can re-assign the port allocation. See Appendix 3: Com Port Conflicts on page 55 for more information.
Appendix 3: Com Port Conflicts

USB and Bluetooth driver software create serial port enumerations. Normally a driver will allocate the next available and unused port, but occasionally port allocation conflict can occur. This would normally happen only if you have mistakenly allocated a connection to a port already in use.

If this problem occurs, then you can re-assign the port allocation:

1. From the Windows Device Manager, double-click the port you want to reassign. The properties window for the port is displayed.

2. Select the Port Settings tab and then click **Advanced**.

3. Using the COM Port Number drop-down list, select the first port that is not in use (COM10 in the example shown) and then click **OK**.

   The properties window is redisplayed.
4. Click **OK**.
   
The Device Manager is redisplayed.

**NOTE:** You may have to close and re-open the Device Manager to show the result of your change.
**Appendix 4: Setting up the COM Port Exclusion List**

Lambda Bio XLS Report Utility searches USB and Bluetooth ports for attached instruments:

- At Lambda Bio XLS Report Utility application start up;
- Using the **Find** facility;
- After updating the port exclusion list;
- After synchronizing date and time.

The Report Utility requests information from the instrument and waits for a response. Where a port is not present or is invalid this is a relatively quick process, but for some ports (Bluetooth, in particular) where the port is present but might be unresponsive a response time out is used. The more ports searched, the longer the process.

To improve search speed the Report Utility allows the creation of a port exclusion list. A port in the exclusion list will not be searched and no connection will be made using it. An instrument attached to a port that is in the exclusion list will not be seen by the Report Utility. A connection currently in force with an instrument that has its port added to the exclusion list will have its connection dropped.

To modify the port exclusion list:

1. Select **Ports to Exclude from search** from the **Tools** menu.
   The Ports excluded dialog is displayed. In this example the port exclusion list is empty.

   ![Ports excluded dialog](image)

2. To add ports to the exclusion list, click **Add**.
   The Select then add dialog is displayed, which lists all the ports that will be searched.

   ![Select then add dialog](image)

   **NOTE:** Only ports seen by the PC that are Bluetooth or USB will be displayed in this list.
3. Select the ports to exclude.

![Select then add dialog]

**NOTE:** Multiple selection is possible using the CTRL or SHIFT key.

4. When you have made your selection, click **Add** to add the ports to the exclusion list and return to the exclusion list dialog.

![Ports excluded dialog]

5. Click **X** to return to the main display and automatically start a new instrument search.

- To remove ports from the exclusion list, highlight the ports first and then click the **X** symbol.

![Ports excluded dialog]